Welcome & Onboarding Guide for Faculty & Staff Members

Online and searchable training guides can be found at: www.Help.CraniumCafe.com
Welcome & Onboarding Guide
WELCOME

Cranium Cafe’s onboarding team is ready to train you, on the first ever real-time student services platform. Our goal was to create software that replicates what you currently do on campus. Volumes of research have concluded that student services such as academic advising, tutoring, and counseling are tightly correlated with retention and graduation.

The Cranium Cafe platform includes an online scheduler, virtual lobby, and a video meeting space. The scheduler, virtual lobby, and video meeting space is yours and you control how students engage with each application. Just like you would control your appointments, open walk-ins, and in-office meetings, you can control your Cranium Cafe function in similar ways.

**First Step:** is to have you log into your school’s Cranium Cafe instance through the StarID single sign-on. The link provided below is your access point to first create your Cranium Cafe account and to login and access your account. Once you open this link, you might want to bookmark it for quick access.

[Link for Bemidji State University - Cranium Cafe single sign-on is:](https://idpstarid.mnscu.edu/idp/Authn/UserPassword)

**Second Step:** is arrange a one-on-one training through the Cafe Card designated for BSU faculty and staff members located here [https://my.craniumcafe.com/cafetraining](https://my.craniumcafe.com/cafetraining). Please click onto “Schedule Meeting” button located within the Cafe Card and find a time that works best with your schedule. Our system will automatically send you a calendar invitation with the meeting link.

Please review the rest of this onboarding document which has more information on setting up your account after you have logged in through the single sign-on. Visit our help website for in-depth searchable help guides and documents located at [www.Help.CraniumCafe.com](http://www.Help.CraniumCafe.com).
See you in the Cafe!

The Cranium Cafe Team

**BEST PRACTICES**

Online students, commuter students, and adult learners find it difficult to meet on campus. So we developed a communication platform that allows off-campus student a way to "knock" on the door of their academic success team from any location, with one-click. Without the assistance of an IT person, you can easily add Cafe Cards right on your webpage so students can talk to specific members of your team for help when they’re online and available. We believe that students who have more face-to-face interactions with their school’s faculty and staff, have a higher level of academic success.

*Add Cafe Cards on home pages of each student services websites. This gives your students direct access to face-to-face communication.

Example: [University of Texas Graduate School](http://example.com)
The departments with the most success implementing Cranium Cafe all did the following:
• Held a training session — virtual or on-campus — with Tracy Gorham or Mike Bills
• Chose high-traffic webpages and highly visible spots for their Cafe Cards with a heading similar to “Chat or Meet with our Advisors now!”
• Sent an email to all students that
• Announced the new tool & that they would be available for online chat, meetings, and scheduling
• Included images
• Included the page link where students could find the Cafe Cards

**Academic Advising:** Cranium Cafe has been a powerful tool to help current and prospective students connect with their academic advisor face-to-face, just like they would if on campus. Embed your Cafe Cards on your advising webpage and tell students to go to the webpage to ”knock” on your Cafe door and start an instant virtual meeting, or self-schedule a meeting for later. Online meetings with Cranium Cafe are particularly beneficial when registering incoming freshmen for classes before the students have moved to campus. Advisors and students can share screens and look through documents together, which helps in explaining requirements, picking courses, and explaining schedules.

**Financial Aid:** include Cafe Cards on your webpage and send this link to students who need to meet with you. Use it as a scheduler for in-office meetings or allow students to self-schedule online meetings as well. Our customers report a significant decrease in back-and-forth emails with students when departments offer regular schedules for one or more staff members to be online and available to answer questions. Online meetings are particularly beneficial for off-campus students or incoming students from out-of-state who haven’t yet moved near campus. You can share screens or mark up documents together to explain financial packages or show students how to fill out their financial aide paperwork.

**Recruitment:** include Cafe Cards for Admissions Officers on your “Future Students” webpage so prospective students immediately see that you are available to answer questions and for more in-depth discussions. Create the opportunity for prospects to develop relationships and form an immediate connection to your school. These online meetings with Cranium Cafe are particularly beneficial for out-of-state prospects because they can immediately begin forming a real relationship (not just through email or via phone) with a representative from your school without traveling to campus. You can also share screens or upload documents so you can view and discuss pamphlets, web pages, or anything else you may want to explain or show the student.

**Extra tip:** in addition to Cafe Cards for Admissions officers, put a Cafe Card for a current student on the webpage so they can have direct face-to-face contact with prospective students and talk about their college experience.
**Tutoring:** create an e-tutoring webpage on your student services site and include Cafe Cards for all of your tutors. Make sure each tutor includes areas of expertise on their Cards and encourage them to set their Cafe Hours so students know when they are available and can self-schedule tutoring appointments.

**Mental Health / Title IX:** Cranium Cafe is a safe environment that promotes the human connection without any physical contact. Students can get help when they need it most without travel and staying anonymous — not seen going into the mental health counselor’s office.

**Help Desk / IT Support:** Faculty, staff, and students can contact their school’s IT and Help Desk with one click and meet virtually. IT support is more efficient and effective when students can share their screens and show the specific technical issues they are experiencing.

**LMS Course Integration**
The courses with the most success implementing Cranium Cafe did all of the following:
- Sent an email to all students that announced the new tool & that they would be available for online chat, meetings, and scheduling
- Faculty required regular one-on-ones meeting throughout the term
- Instructor encouraged group meetings between students

**Instructor Office Hours:** do your office hours from the office, your home, the beach — anywhere. Whenever you’re logged in, your light shows as green so students know you’re available to chat or Cafe. Set Cafe Hours so students can see when you’ll be online and so students can self-schedule meetings with you.

**Teacher Assistants:** encourage your TAs to be available online at regular times so students can go to them with questions or tutoring sessions.

**Student-to-Student Collaboration:** Encourage students to set their own hours or to log in while working on assignments. When a student goes to the Cranium Cafe tab within an LMS course, it’s similar to walking into a food court, except each station is a student who can choose be available to other students. Clicking to initiate a chat with another student is easier than other study group options because students don’t have to hassle with:
- Exchanging personal contact information
- Scheduling a time & place to meet
- Downloading or installing any software

**Retention Outreach:** Cafe with your students when they’re online to touch base or discuss assignments, attendance, or in-class performance.
TECHNICAL REQUIREMENTS

Cranium Cafe’s Real-Time Student Services software was built to simulate an in-office appointment specifically designed to extend the reach to all off campus students. The Cafe is an intuitive and user-friendly real-time meeting & collaboration platform that requires no download or installation. Students can “knock” on the door of their academic support team and receive immediate help regardless of location or ability.

Desktop PC and Mac meeting requirements:
- Use Chrome or Firefox
- Have your web camera ready and activated
- Have a headset with microphone ready — your cell phone headset will work great

Android and Window device meeting requirements:
- Use Chrome
- Have your web camera ready and activated
- Have a headset with microphone ready — your cell phone headset will work great

iOS - Apple Device meeting requirements:
- Currently iOS devices can “knock” on the door, instant chat, and schedule a meeting with their handheld device through Safari and Chrome browsers. There is no need to download and install an application. The video meeting portion of Cranium Cafe is not supported on iOS devices and a message in the Cafe Chat box will appear indicating this.

FACULTY & STAFF ACCESS PANEL

After you log into your Cranium Cafe account through your school’s single sign-on, you will be directed to your self-hosted Cafe Card. We created this page for faculty and staff members who do not have access to their school’s website to embed their Cafe Card. Your self-hosted Cafe Card will have a unique URL address which can be sent to others so they can “knock” on your door and schedule meetings through your Cafe Card. Your unique URL address will and in our user name. Example: https://my.craniumcafe.com/USERNAME
You will find direct links to your profile settings and admin panel. Click onto “Settings” in the upper right hand of the screen to access your personal Cranium Cafe account settings. You will be directed to your settings area which include Appointments, Cafe Hours, Archives, Profile, and Help.

PROFILE TAB: PERSONALIZING YOUR CAFE CARD SETTINGS

We will begin with customizing your Cranium Cafe Card and profile. As you know, Cranium Cafe allows students to initiate instant communication with their academic support team at the same time it allows faculty and staff to control the communication. By customizing your Cafe Card and profile settings, you can determine when meetings will happen, the length of meetings, when students can schedule, and control when your “Knock on Door” button is available.
Personalizing Your Cafe Card

**Online Presence:**
Open office hours and walk-in appointments

**Cafe Card:**
Embeds easily into any webpage
Nothing to download or install

**Personalized Image:**
Profile photos create instant rapport and trust

**Personalized Card:**
Customized to each faculty/staff
Preference settings replicate how faculty currently meet with their students

**Instant Communication:**
Allows students to “knock” on the door just like they would when on campus

**Self Scheduling:**
Outlook & Google calendar integration
Customized scheduling preferences

---

**Personalizing Your Cafe Card**

**Personalize your Cafe Card by adding a profile photo, short biography, and preferred contact information.**

Once logged into your Cranium Cafe account, navigate to the “Profile” tab. The first section of the Profile settings relate to your Cafe Card and what is shown online. Add information that your students will find helpful in connecting with you.

To personalize your Cafe Card, follow these steps:

1. Click "Upload Photo" and choose a picture file from your computer or external hard drive
2. Add name, title, email, and an address or phone to the corresponding fields
3. Create a bio for others to read — you can copy & paste from a word document or your LinkedIn bio
Determine & Manually Set Online Status

**Cafe Online Status Settings** allow you to:

- Manually set your status to "away" with a personalized message
- Set the amount of time before your status automatically sets to "away"
- Choose to have only one Cafe Chat at a time (while in a Cafe Chat or a Cafe Meeting, the status light next to your profile name will turn yellow, and no one else will be able to chat or Cafe with you until you close your previous conversation)

---

**Cafe Scheduler Settings** allow you to customize how people self-schedule appointments with you and how we send you appointment reminders. The Cafe Scheduler offers you these options:

1. Offer appointment location options to people self-scheduling appointments with you
2. Select Cafe Scheduler iCal feed to add to your personal Yahoo or Google Calendar (learn more here)
3. Limit the amount of time others can self-schedule with you
4. Block others from self-scheduling short notice appointments
5. Set when you want to receive appointment reminder emails
6. Add your cell phone number for SMS text appointment reminders
7. Allow your cell or office phone number to be visible on your Cafe Card
8. Opt to receive SMS text appointment reminders
9. Select your cell phone carrier
10. Select your time zone
Change Cafe Username

**Cafe Username Settings:** allow you to create a vanity name and personalize your Cafe’s name. To do this, follow these steps:

1. Click "Change My Cafe Username"
2. In the new window that appears, pick a new Username while following the tips that appear above the text boxes
3. Enter your password and click "Save"

Change Password

**Password Settings:** allow you to change your password and request a forgotten password. To change your password, follow these steps:

1. Enter your old password in the first field
2. Enter your new password in the second field
3. Enter your new password again in the third field for confirmation
4. Click "Update Password"
CAFE HOURS TAB: SETTING OFFICE HOURS

Cranium Cafe meetings can be scheduled right from the Cafe Card. When the student clicks on “Schedule Meeting” button, they first go through the authorization process. When they are authorized, the scheduler will appear within the same webpage — they always stay on the school’s website and never redirected.

Setting Cafe Hours

NOTE: This setting is only for Google Calendar and iCal integrations. This is not a required step when using the Cranium Cafe Outlook Plugin.

Your Cafe Hours are the times during which others can self-schedule appointments with you. To set your Cafe Hours, follow these steps:

1. Log in to your Cranium Cafe account
2. Navigate to the “Cafe Hours” tab
3. Click once within the calendar — a manual configuration box will appear
4. Select the start and end time
5. Set this time block for a single day or as a recurring event
6. Click “Save”
Integrate & Configure Your Preferred Calendar

You can configure your preferred calendar to interact with your Cafe Scheduler where others see your availability and self-schedule appointments. Configuring your preferred calendar will allow flexibility and auto calendar population with a push/pull method.

OUTLOOK CONNECTOR - WINDOWS VERSION

The Cranium Cafe Outlook Plugin gives you total control over your Cafe Hours from your Outlook Calendar. The plugin is a push/pull custom Outlook integration for the Cafe Scheduler. You can change scheduled Cafe appointments and update your Cafe Hours with just a few clicks.

Download Links:

Cranium Cafe Outlook Connector DOWNLOAD (for 32-bit Outlook)

Cranium Cafe Outlook Connector DOWNLOAD (for 64-bit Outlook)

- Documentation: Step-by-Step Guide
- Outlook Connector Add-In Issue Guide

OUTLOOK CONNECTOR - MAC VERSION

Steps within this guide:

1. Customize your Cranium Cafe account & copy iCal feed
2. Open Mac Calendar & Add Cranium Cafe iCal feed code: File > New Calendar Subscription > Paste Code
3. Export Cranium Calendar iCal Feed: Highlight the Calendar > File > Export > Select where to save > Export button
4. Import into Outlook: Open Outlook > Go to Calendar view > Drag the exported calendar file into the any area of the Outlook calendar

Video Tutorial Located Here: https://help.craniumcafe.com/calendar-settings/
GOOGLE ICAL CONFIGURATION

Your personalized Cafe Hours can be integrated into your Yahoo, Google, or Mac iCal calendar. Below is a step by step how-to guide to walk you through the Google Calendar integration process.

**Step 1:** Copy the “My Cafe iCal Feed” address found in your "Profile" tab.

**Step 2:** Log in to your Google Calendar, click the "Other calendars" drop down arrow, and select the "Add by URL" option.

**Step 3:** Paste the “My Cafe iCal Feed” address into the URL field and click “Add Calendar.” Your Cafe Hours are now integrated into your Google Calendar.

**Step 4:** Return to the “Profile” tab and scroll down to the “Scheduler Integrations” area.

Click onto “Connect Google Calendar” and sync your Google account with your Cranium Cafe account.
APPOINTMENTS TAB: LIST OF MEETINGS

The Appointments tab allows you to see all your upcoming appointments in a one-page view. You have access to the message sent from the person who scheduled the meeting and a direct link to download the document that was attached to the scheduled meeting. There is a “Cancel” button that will allow you to cancel the meeting with a personalized message.

NOTE: The meeting message, information and document download is also integrated into your Outlook & Google Calendar when your Cranium Cafe is integrated into your preferred calendar.
ARCHIVES TAB: CHAT & MEETING ARCHIVES

Within the Archives page, you can access chat histories and playback meetings. The delete function allows you to control your archive storage.

“Start a Solo Recording” button launches your Cafe (video meeting) where you can test settings and upload documents into your Document Library prior to a scheduled or instant meeting.

NOTE: Solo Recording is a great way to practice the Cranium Cafe meeting tools before meetings begin.
CAFE CARD: WORDPRESS INTEGRATION

The Bemidji State University and web development team has created a WordPress application for Cranium Cafe group and single Cafe Card integrations. For the latest update on the steps to integrate your Cafe Card into a specific webpage, please follow the links to the BSU website.

Adding a Single Cranium Cafe Card in WordPress

Please go to the follow BSU webpage for up-to-date information and step-by-step guides on a single Cafe Card webpage integration. This guide can be found here: http://www.bemidjistate.edu/offices/its/knowledge-base/adding-a-cranium-cafe-card-in-wordpress/

Adding Group Cranium Cafe Cards in WordPress

Please go to the follow BSU webpage for up-to-date information and step-by-step guides on a group Cafe Card webpage integration. This guide can be found here: http://www.bemidjistate.edu/offices/its/knowledge-base/adding-a-cranium-cafe-group-card-in-wordpress/
HELP TAB: DIRECT LINK TO HELP CENTER

A Cranium Cafe Meeting Tester is located within the Help tab. The Meeting Tester will test the camera, microphone, and internet speed. There is a direct link to the Cranium Cafe Help Center where you can find in-depth documentation, video tutorials, and submit a help ticket to Cranium Cafe.

Thank you for reviewing the Welcome - Onboarding Guide! Let us know your Cranium Cafe experience by emailing us directly at info@craniumcafe.com.

The Cranium Cafe Team
801-935-4244